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 The Granville High School Style Book 

 
 

 
Introduction 
 
 
We are proud to introduce the second edition of The Granville High School Style Book.  

 
Based on the MLA Handbook for Writers of Research Papers, this handbook represents a common set of “rules” 
for all Granville students and teachers to follow. Whether you are writing a paper about Romeo and Juliet for 
English 9 or writing your senior research paper, you will be following the same conventions for documenting 
research in every class during your academic career at GHS. 
 
You may wonder why a style guide is necessary at all.  
 
Imagine, if you will, a football game in which the players for Granville line up against Johnstown, with each 
team playing by a different set of rules. The end result would be confusion for players, referees, and even fans. 
No one would enjoy the game, and it would be unclear who won. 
 
The same concept applies to academic research. MLA style represents a consensus among teachers, scholars, 
and librarians on how to conduct research in liberal arts and the humanities. By following the conventions and 
documentation rules set forth in the handbook, your readers will be able to focus on what is most important—
the exploration of your ideas. 
 
Dubbed the “style bible for most college students” by Newsweek magazine, the MLA Handbook for Writers of 
Research Papers has been widely adopted by universities, colleges, and secondary schools for over half a 
century. By providing step-by-step guidelines for writing research papers, MLA style is recognized for its 
simplicity and flexibility. 
 
Although widely used in the humanities, MLA style is not the only way to document sources. At the collegiate 
level, you may be required to use another system, such as American Psychological Association (APA). Do not 
fret, however; if you learn MLA documentation style at this stage of your school career, you will have little 
difficulty adapting to other styles. 
 
So whether you are destined for American University, Miami University, or OSU Newark, you will leave 
Granville High School with a solid understanding of the format and style of documenting sources your 
professors will require. No matter what career you intend to pursue, identifying and analyzing the work of other 
researchers will play a major role in your development of as a student.  
 
And the skills you will gain through the research process are not limited to the academic arena. The ability to 
consult authoritative sources about a topic, to integrate the information with your own thoughts, and to present 
your ideas thoughtfully are skills that are required in any field.  
 
We wish you the best as you begin the intellectually rewarding process of research writing. We look forward to 
reading what you have discovered along the way. 
 
 
The Granville High School English Department 
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Proper Use of MLA Format 
 
The MLA is the Modern Language Association of America. It is a group that was founded in 1883 as an 
organization whose goal was to “strengthen the study and teaching of language and literature.”  The MLA 
recommends a style for the mechanics of writing that is used in liberal arts and the humanities, and it assures 
that all papers appear the same and are graded on content rather than visual appearance. The basic rules of the 
format are: 
 

• Font is Times New Roman, 12 point size 
• Margins are one inch all around: top, bottom, right, and left 
• Writing is doubled-spaced 
• There is no title page 
• A heading on the top left of the first page (also in Times New Roman) includes the writer’s name, the 

teacher’s name, the class name, and the date. It is one inch from the top, thus falling within the regular 
margin of the page. 

• The title appears after the heading. It is not italicized, underlined, nor is it placed in quotes or boldface 
or typed in all capital letters. 

• A header on the top right of each page is one half inch from the top.  It contains the last name of the 
writer and the page number of the paper. 

 
How to use Microsoft Word to set up MLA Format: 
Note: The following actions should be performed before typing anything in to the document.   
 

1.  Open a new document and select the Layout tab.  Click the Margins option, and choose the Normal 
setting – all four sides should be 1”.  Click it and double check the document to see that the margins are 
indeed one inch on all sides. 
2.  Select the Home tab.  In the Paragraph section, click the line spacing button (there are two arrows 
and four lines on it).  Select 2.0 to double space the document.  Also in the Home tab, assure that the font 
is Times New Roman and the size is 12. 
3.  Select the Layout tab. In the Spacing section, change Before and After to both read 0 pt.  
4.  Select the Insert tab.  Click the Page Number icon in the Header & Footer section.  Choose the Top 
of Page option, then click Plain Number 3.  Click the cursor in front of the number 1 that appears.  Type 
your last name and hit the space bar once.  Now highlight your last name and the number, and click on 
the Home tab again.  Change the font for the header to Times New Roman 12 the same way.  Double 
click on the body of the page to return to the body. 

 
How to use Microsoft Word to set up a Works Cited Page: 
 

1.  After creating the document, select the Insert tab, and in the Pages section, select Page Break.   
2. On the top line of the page, type Works Cited and center it.  Do not use italics, underlining, bold, or 
quotation marks.  Use size 12 font in Times New Roman.  Do not type Work Cited – you cited multiple 
works, so your title must be plural to reflect that. 
3.  In order to set the Hanging Indent, select the Layout tab, and in the Paragraph section, expand the 
arrow in the lower right corner.  Under Indentation, select Special and Hanging.  Click OK, and this will 
assure that the second and subsequent lines of each source are indented.   
4.  Type the first entry carefully into your document. 

 
For a visual sample of these items, refer to pages 2 and 14
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                                                                                                                                              Student 1 

Johnny A. Student 

Miss Poppy  

American Lit and Comp 

16 March 2016 

Researching the Research Paper 

Old adages point out that writers can never truly create something completely new.   

Luckily, when students are required to write a research paper, their teachers are not asking them 

 to create something new.  The students must instead gather various sources, sift through them to 

 select important information, and organize their notes into a paper.  Librarians might guide the 

 research paper writers to magazines, newspapers, books, articles from online databases, or works 

from web sites.  No matter from where the information comes, it is not the students’ own ideas.  It  

is therefore crucial for students to clearly indicate when they are using information from an outside  

source.  To fail to do so is plagiarism.  Students should indicate the place where information was  

found, but this can distract the reader from the paper itself.  In-text citations are a tool for student to  

          recognize outside sources without interrupting the flow of writing.   

Here are some examples of commonly used sources and the in-text citations that let readers 

 know where to find the facts that the student writer used.  Playing games with co-workers can help  

pass the time and build important friendships (“Pranking Master”).  Some judges express their  

opinions bluntly, using statements like “I can’t stand people who think they can sing” (Cowell 38).  

Writer’s last name and 
page number are ½ inch 
from the top of the paper 

in Times New Roman font 
 

1 inch margins all 
 around the paper 

 

Title is centered,  
not bold or italicized 

 

Writing is double-spaced throughout the paper and  
skips every other line – the distance between 
paragraphs is the same as it is between lines 
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Locating Resources in the Library  
The Granville High School Library is a great source for both research and lighter reading. In addition, there are 
state-of- the-art computers and a media room to assist in making videos, presentations, and posters. Whether at 
home or school, you can easily access the library’s home page to see the selection of books on the on-line 
catalogue or connect to one of several online research sites. 
 
THE PHYSICAL LIBRARY: THE DEWEY DECIMAL SYSTEM 
Look for the labels on the bookshelves throughout the library to locate the appropriate section

000 Generalities  
100 Philosophy & psychology  
200 Religion  
300 Social sciences  
400 Language  

500 Natural sciences & mathematics  
600 Technology (Applied sciences)  
700 The arts   
800 Literature & rhetoric  
900 Geography & history

THE ONLINE LIBRARY 
Each of the following sources is available on the Granville High School web site in the Library section. Make 
notes below of usernames and passwords, which may expire with each school year. 
 
Gale GREENR Database 
A reference on the environment, energy, and natural resources. 
 
Gale Global Issues in Context Database 
A reference on current global issues and trends. 
 
Gale Virtual Reference Library 
A database of specialized encyclopedias on a variety of subjects.  These are trusted, authoritative reference works that 
were first published in print. 
 
Contemporary Literary Criticism Online 
A reference for modern literary criticism. 
 
Oxford University Press Islamic Studies Online  
Primary Source Documents, Learning Resources, Image and Maps, Biographies and Interviews.  
 
Oxford University Press Very Short Introductions  
Intelligent and serious introductions written by authors who are experts in their field.  
  
INFOhio 
The Information Network for Ohio Schools that houses a variety of databases 
 
The Oxford Encyclopedia of British Literature 
A specialized encyclopedia of British Literature 
 

 

Remember that general research encyclopedias like World Book or Britannica are  
not acceptable to use as cited sources, nor may they appear on the works cited page.  

http://www.library.illinois.edu/cms/ugl/about/dewey.html#000
http://www.library.uiuc.edu/ugl/about/dewey.html#100
http://www.library.uiuc.edu/ugl/about/dewey.html#200
http://www.library.uiuc.edu/ugl/about/dewey.html#300
http://www.library.uiuc.edu/ugl/about/dewey.html#400
http://www.library.uiuc.edu/ugl/about/dewey.html#500
http://www.library.uiuc.edu/ugl/about/dewey.html#600
http://www.library.uiuc.edu/ugl/about/dewey.html#700
http://www.library.uiuc.edu/ugl/about/dewey.html#800
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Evaluating Sources of Information 
 
When writing a research paper, you will need to make decisions about what to search for, where to look, and 
once you've found material on your topic, if it is a valid or useful source for your writing. Not all sources are 
equally reliable or of equal quality. You must carefully evaluate each source before using it in your research  
paper.  
 
When searching for information in library catalogues and online article databases, you will first find a 
bibliographic citation entry. A bibliographic citation provides relevant information about the author and 
publication as well as short summary of the text. Before you read a source or spend time hunting for it, begin by 
looking at the following information in the citation to evaluate whether it's worth finding or reading.  
 
After you have asked yourself some questions about the source and determined that it's worth your time to find 
and read the source, you can evaluate the material in the source as you read through it. Consider the following: 
 
 
Who 
• Who is the author of the work? 
• Is the author qualified to address the subject?  What are his or her credentials? 
 
 
What 
• What is the source?  Is it a primary source or a secondary source? 
• Does it document its own sources in a trustworthy manner? 
 
 
How 
• How was the source produced?   
• Does it have a recognized publisher or sponsor? 
• Was the source edited by others or peer reviewed? 
 
 
Where 
• Where did you find the source?   
• Was it cited in a work of authority?   
• Did you discover it through a search engine that may receive compensation or sponsorship for its              

recommendations? 
 

 
When 
• When was the source published? 
• Could its information be replaced with something more recent? 
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A Special Note about Internet Sources 
 
With the advent of the World Wide Web, there has been a massive influx of digital texts and sources available 
electronically. While some sources on the Internet can be found in print format, such as newspapers and maga-
zines, much of what is found on the Internet does not have a print equivalent, and hence, has low or no quality 
standards for publication. The table below notes the differences between print sources and web sources. 
 

Print Sources Internet Sources* 
Traditional print sources go through an extensive 
publication process that includes editing and article 
review. The process has fact-checkers, multiple re-
viewers, and editors to ensure quality of publication. 

Anyone with a computer and access to the Internet 
can publish a website or electronic document. Most 
web documents do not have editors, fact-checkers, or 
other types of reviewers. 

Print sources clearly indicate who the author is, 
what organization(s) he or she is affiliated with, and 
when his or her work was published. 

Authorship and affiliations are difficult to determine 
on the Internet. Some sites may have author and 
sponsorship listed, but many do not. 

External sources of information and direct  
quotations are clearly marked and identified. 

Sources the author used or referred to in the text may 
not be clearly indicated in an Internet source. 

While bias certainly exists in traditional publica-
tions, printing is more expensive and difficult to  
accomplish. Most major publishers are out to make a 
profit and will either not cater to special interest 
groups or will clearly indicate when they are cater-
ing to special interest groups. 

The purpose of the online text may be misleading. A 
website that appears to be factual may actually be 
persuasive and/or deceptive. 

Qualifications of an author are almost always  
necessary for print sources. Only qualified authors 
are likely to have their manuscripts accepted for  
publications. 

Even if the author and purpose of a website can be 
determined, the qualifications of the author are not 
always given. 

Publication information such as date of publica-
tion, publisher, author, and editor are always clearly 
listed in print publications. 

Dates of publication and timeliness of information 
are questionable on the Internet. Dates listed on web-
sites could be the date posted, date updated, or a date 
may not be listed at all. 

 
*In this example, the term Internet sources does NOT refer to electronic sources that are accessed 

through the library, which are listed on page 3. 
 
 
Due to the discrepancy between the quality of print sources and Internet sources, you must be very careful about 
what, if any, information you decide to use from the World Wide Web. In addition to sites that your teacher may 
mention, the following Internet sources are also NOT appropriate for academic research.   
 
 

Wikipedia 
Barnes and Noble 

Amazon 
Sparknotes 

Yahoo Answers 
Ask.com 

Buzzle 
Infoplease 

blogs by non-experts 
Facebook 

Twitter 
About.com 

Shmoop.com 
Thinkexist.com 
Schoolnet.com 
Britannica.com 

Encyclopedia.com 
Bartleby.com 

Classbrain.com 
Woopidoo.com 

Bookrags 
Pink monkey 

Enotes 
Alibris.com
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The Mechanics of Writing   
 
Poor presentation of mechanics may interfere with your ideas; therefore, you must apply the knowledge and 
skills you have acquired through previous writing experiences when writing a research paper. The following 
section addresses some of the mechanical issues you will most likely encounter while writing research papers. 
 
SPELLING 
1. Spelling should be consistent throughout the research paper. 
 
2. If a dictionary lists more than one way to spell a word, use the first spelling in the entry. 
 
3. When directly quoting material, retain the spelling of the original, regardless of whether it is correct or in-

correct. 
 
4. If you quote material written in a foreign language, you must reproduce all accents and other marks. 

 
 
PUNCTUATION 
Commas 
1. Use a comma before a coordinating conjunction (and, but, for, nor, or, so, yet) joining independent  

clauses. The comma may be omitted when the sentence is short. 
• The poem is ironic, for the poet’s meaning contrasts with her words. 
 

2. Use commas to separate words, phrases, and clauses in a series. 
• Austen’s novels have inspired films, plays, and numerous works of fan fiction. 
• To prepare for the exam she reviewed her notes, reread a novel, and made flashcards.  
 

3. Use a comma between coordinate adjectives (adjectives that separately modify the same noun). 
• Critics praise the novel’s unaffected, unadorned style. 
 

4. Use commas to set off a parenthetical comment, or aside, if it is brief. 
• F. Scott Fitzgerald, for example, wrote about the decline of the American dream. 
 

5. Use commas to set off a nonrestrictive modifier—that is, a modifier that is not essential to the meaning of 
the sentence and may be dropped without changing the main idea. 

• Gabriel García Márquez, the Colombian novelist, will speak at Denison University. 
 

6. Use a comma after a long introductory phrase or clause. 
• Although she was virtually unknown in her day, scholars have come to recognize the originality of 

her work. 
 

7. Use commas to set off alternative or contrasting phrases. 
• It is Julio, not his mother, who sets the plot in motion. 
 

8. Use a comma in a date whose order is month, day, and year.  
• Chinua Achebe was born on November 16, 1930. 
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Do not use commas in the following instances: 
1. Do not use a comma between subject and verb. 

• Many of the characters who dominate the early chapters and then disappear [no comma] are portraits 
of the author’s friends. 

 
2. Do not use a comma between a verb and object. 

• The scout reported [no comma] that the enemy was preparing for battle. 
 

3. Do not use a comma between parts of a compound subject, compound object, or compound verb. 
• Hemmingway is known for his novels [no comma] and his short stories. 

 
4. Do not use a comma between two parallel subordinate elements. 

• She broadens her analysis by exploring the tragic elements of the play [no comma] and by 
 integrating the hunting motif with the themes of death and resurrection. 

 
Semicolons 
1. Use a semicolon between independent clauses not linked by a conjunction. 

• Fitzgerald’s career was ruined by alcoholism; yet, he continued to drink. 
 

2. Use semicolons between items in a series when the items contain commas. 
• My sister has lived in Alpharetta, Georgia; Maplewood, New Jersey; and Pittsburgh, Pennsylvania. 

 
Colons 
1. Use a colon to introduce a list, an elaboration, or the formal expression of a rule or principle. 

• LIST: The reading list includes three Latin American novels: The Death of Artemio Cruz, One  
Hundred Years of Solitude, and The Green House. (But do not use a colon before a list if the list is 
grammatically essential: The novels on the reading list include The Death of Artemio Cruz, One 
Hundred Years of Solitude, and The Green House.) 

• ELABORATION: The plot is centered on deception: the three characters each hide a secret. 
• RULE: Many students would not plagiarize if they followed one simple rule: Never pass off another 

person’s ideas, information, or expression as your own. 
 

2. Use a colon to introduce a quotation that is independent from the structure of the main sentence. 
• In The Awakening, Mme Ratignolle exhorts Robert to stop flirting with Edna: “She is not one of us; 

she is not like us.” 
 
Dashes and Parentheses 
1. Use dashes or parenthesis to enclose an element that interrupts the train of thought. 

• The “hero” of the play (the people see him as heroic, but he is the focus of the author's satire)  
introduces himself as a veteran. 

 
2. Use dashes or parenthesis to set off a parenthetical element that contains a comma. 

• The school colors—blue and white—adorned the hallways. 
 

3. Use a dash to introduce words that summarize a preceding series. 
• Ruthlessness and acute sensitivity, greed and compassion—the main character’s contradictory  

qualities prevent any simple interpretation of the novel. 
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Hyphens 
1. Use a hyphen in a compound adjective beginning with an adverb such as better, best, ill, little, or well. 

• well-dressed author 
2. Use a hyphen in a compound adjective ending with the present participle or the past participle. 

• sports-loving crowd 
 

3. Use a hyphen in a compound adjective formed by a number and a noun when the adjective precedes a 
noun. 

• four-year-old boy 
 

4. Use hyphens in other compound adjectives before nouns to prevent misreading. 
• Spanish-language student (a student who is studying Spanish) 

 
5. Use hyphens to join coequal nouns. 

• scholar-athlete award 
 
Do not use hyphens in these instances: 
1. Do not use a hyphen in a compound adjective beginning with an adverb ending in –ly or with too, very, 

or much. 
• too hasty judgment, very contrived plot, thoughtfully presented thesis 

 
2. Do not use a hyphen in familiar unhyphenated compound terms 

• social security, high school, liberal arts 
 

3. Do not use a hyphen in a pair of nouns in which the first noun modifies the second 
• father figure, opera lover 

 
4. Do not use hyphens after prefixes. 

• antiwar, coworker, overscheduled 
 

Apostrophes 
1. To form the possessive of a singular noun, add an apostrophe and an s.  

• The poem’s meter 
 

2. To form the possessive of a plural noun ending in s, add only an apostrophe. 
• The boys’ soccer team 

 
3. To form the possessive of nouns in a series, add a single apostrophe and an s if the ownership is shared. 

• Sara and Jared’s father 
 

4. If the ownership is separate, place an apostrophe and an s after each noun. 
• Shelley’s and Keats’s poems 

 
5. To form the possessive of a plural proper noun, add only an apostrophe. 

• the Twains’ economic problems 
 

6. Do not use an apostrophe to form the plural of an abbreviation or a number. 
• PhDs, TVs, 1990s, SAT score in the 1400s 
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Quotation Marks 
1. Place quotation marks around a word or phrase given in someone else’s sense or in a special sense. 

• Their “friend” reported them to administration. 
2. Use quotation marks for a translation of a foreign word or phrase. 

• Plagiarism is derived from the Latin word plagiarius (“kidnapper”). 
 
Square Brackets and Slashes 
1. Use square brackets around a parenthesis within a parenthesis. 

• The author known as Mark Twain (Samuel Langhorne Clemens [1835-1910]) is a famous American 
novelist and humorist. 

Slashes 
1. Use a slash in quotations of poetry (see page 10). 
 
2. Use a slash between two terms paired as opposites. 

• The writer explores fundamental oppositions like good/evil, East/West, and young/old. 
 
Periods, Question Marks, and Exclamation Marks 
In general, follow normal rules for end punctuation. When using questions marks, follow these rules: 
1. Place a question mark inside a closing quotation mark if a question mark occurs there in the quoted passage. 

• Whitman asks, “Have you felt so proud to get at the meaning of poems?” 
 

2. If the quotation ends a sentence that is a question, place a question mark outside the quotation. 
• Where does Whitman speak of “the meaning of poems”? 

 
3. If a question mark occurs where a comma or period would normally be required, omit the comma or period. 

• “Have you felt so proud to get at the meaning of poems?” Whitman asks. 
 
Spacing after Concluding Marks 
Many publishers’ guidelines for preparing a manuscript’s electronic files ask professional authors to type only 
one space after concluding marks. As a practical matter, there is nothing wrong with using two spaces after 
concluding punctuation marks unless an instructor asks you to do otherwise. Whichever spacing you choose, be 
consistent in all parts of your paper, including the works-cited list. 
 
ITALICS 
1. Italicize words and letters that are referred to as words and letters. 

• The word plagiarism means “to commit literary theft.” 
 

2. Italicize foreign words used in an English text.  
• Exceptions: quotations entirely in another language (Caesar said, “Veni, vidi, vici.”) and adopted for-

eign words (ad hoc, et al., hubris, etc.) 
 

3. Italics for emphasis (“Jefferson does admit, however…”) is a device that becomes ineffective and is rarely 
appropriate for research writing. 
 

NAMES OF PERSONS 
1. In general, the first time you use a person’s name in your research paper, state it fully and accurately. 

• Emily Dickinson 
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2. In subsequent use, use the last name, omitting any formal titles. 
• Dickinson (not Miss Dickinson) 

 
3. Refer to fictional characters in the same way. You need not always use their full names, and you may retain 

titles.  
• Dr. Jekyll 

 
NUMBERS  
1. Spell out numbers written in one or two words and represent other numbers by numerals. 

• one, thirty-six, one hundred, two thousand, three million, 2 ½, 101, 137, 1,275 
 

2. Use numerals for all numbers that precede units of measurement. 
• 16 amperes, 5 milliliters 

 
3. Do not begin a sentence with a numeral. 

• Two thousand four was an election year in the United States. 
 

4. Use numbers with abbreviations or symbols (6 lbs.), in addresses, in dates, in decimal fractions  
(4.5 million), and in divisions (page 7). 
 

5. Express related numbers in the same style. 
• exactly 3 automobiles and 129 trucks 

 
6. Places commas in numbers (1,000) except in page and line numbers (line 1014), addresses  

(4132 Broadway), and years (2011). 
 
7. Treat percentages and amounts of money like other numbers: use numerals with the appropriate symbols. 

• 1%, $5.35, $35 
 

8. Be consistent in writing dates: use the day-month-year style (22 July 2012). Do not use a comma between 
month and year (August 2012). 
 

9. In a range of numbers, give the second number in full for numbers through ninety-nine (21-48). For larger 
numbers, give only the last two digits of the second number, unless more is necessary (96-101; 103-04; 
2,003-05). 

 
10. Use capital roman numerals for the primary divisions of an outline and after the names of persons in a se-

ries. 
• Elizabeth II, John D. Rockefeller IV 

 
TITLES OF WORKS 
1. When citing the title of a work, follow standard capitalization rules. Capitalize the first word, the last 

word, and all principal words. Do not capitalize the following when they fall in the middle of the title:  
articles (a, an, the), prepositions (against, in, of, to), coordinating conjunctions (and, but, or), and the to in 
infinitives (as in How to Play Chess). Do not reproduce any unusual or artistic typographic characters, such 
as all capitalization or lowercasing of all letters. You may shorten a title if you cite it often in the text of your 
paper after stating the full title once.  

• Incorrect: storage & display; Correct: Storage and Display 
• Incorrect: facebook; Correct: Facebook 
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2. Use a colon and a space to separate a title from a subtitle 
• Liverpool: Wondrous Place 

 
3. Italicize the name of books, plays, poems published as books, pamphlets, periodicals, Web sites, online  

databases, films, television and radio broadcasts, compact discs, albums, dance performances, operas, long 
musical compositions, works of visual art, ships, aircraft, and spacecraft. 

• 1984, New York Times, MasterFile Premier, The Office, USS Arizona, Challenger 
 

4. Use quotation marks for the titles of articles, essays, stories and poems published within larger works, 
chapters of books, pages in Web sites, individual episodes of television and radio broadcasts, and songs. 

• “The Lottery”  
 

5. There are some exceptions that do not require italics or quotation marks: 
• Scripture: Bible, Old Testament, Genesis, Koran, Talmud 
• Laws, Acts and Political Documents: Magna Carta, Declaration of Independence 
• Musical compositions identified by form, number, and key: Beethoven’s Symphony no. 7 in A 
• Series: Masterpiece Theater 
• Societies: American Medical Association 
• Buildings and Monuments: Sears Tower 
• Conferences, Seminars, Workshops and Courses: English 9, Military History 

 
QUOTATIONS 
Short excerpts or quotations are four or fewer typed lines of prose and poetry.  

• To use them in a piece of writing, enclose the quotation within double quotation marks and incorporate it 
into your text.  Provide the author and page number in an in-text citation. In the case of poetry, provide 
line numbers.  

 
• For lines of poetry, separate lines by a slash (/) with a space before and after the slash.   

 
• Punctuation marks such as periods, commas, and semicolons should appear after the parenthetical 

citation.  Question marks and exclamation points should appear within the quotation marks if they are a 
part of the quoted passage, but after the parenthetical citation if they are a part of your text.  

 
• Use single quotation marks for quotations within a quotation.   

 
• Words omitted are shown by an ellipsis, or three periods with a space between each and a space before 

the first period and after the last. 
 
Examples: 

• According to some, dreams express “profound aspects of personality” (Foulkes 1). Others disagree with 
this statement and take the alternate perspective. 

 
• The first two lines of the poem remind one of a nursery rhyme: “My little horse must think it queer / To 

stop without a farmhouse near” (Frost 7-8).   
 

• Mr. Darcy confesses, “I have been a selfish being all my life, in practice, though not in principle. . . Such 
I was, from eight to eight and twenty; and such I might still have been but for you, dearest, loveliest 
Elizabeth!” (Austen 231). 
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Long excerpts or quotations are more than four typed lines of prose or poetry. 

• To use them in a piece of writing, set them off from the text by beginning a new line and indenting one 
inch from the left margin. Type it double-spaced without adding quotation marks around it. Use double 
quotation marks for quotations within a long quotation.  The parenthetical citation should come after the 
closing punctuation mark.  When quoting poetry, maintain original line breaks.  
 

• To quote dialogue between two or more characters in a play, set the quotation off from the text. Begin 
each part of the dialogue with the character’s name written in all capital letters, followed by a period. 
Indent all subsequent lines in the character’s speech an additional quarter inch. Stat a new line when the 
dialogue shifts to another character. 

 
Examples: 
 
Ralph and the other boys finally realize the horror of their actions: 
 
 The tears began to flow and sobs shook him.  He gave himself up for the first time on the island; 
  

great shuddering spasms of grief that wrenched his whole body.  His voice rose under the black  
 
smoke before the burning wreckage of the island; and infected by that emotion, the other boys 
  
began to shake and sob too. (Golding 186) 

 
 Elizabeth Bishop’s “In the Waiting Room” is rich in evocative detail: 
 

The waiting room 
 
 was full of grown-up people, 
  

arc tics and overcoats, 
  

lamps and magazines. (6-10) 
 
 

A short time later Lear loses the final symbol of his former power, the soldiers who make up his train: 
 
 GONIERIL.   Hear me, my lord. 

     What need you five-and-twenty, ten or five, 

     To follow in a house where twice so many 

     Have a command to tend you? 

 REGAN.         What need one? 

 LEAR. O, reason not the need! (2.4.254-3). 
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An ellipsis is three equally spaced dots used to indicate that something has been omitted from a quoted passage. 

• Ellipses should be used when any words are removed from a sentence, but the sentence should still be 
grammatically correct.   

• Use ellipses carefully.  Don’t leave out a part of a passage that would affect its overall meaning. 
• When you omit the last part of a quoted sentence, add a period after the ellipses. 
• When citing after an ellipses, the quotation mark goes before the citation and the period after. 

 
Examples: 
 
ORIGINAL SOURCE:  “The quasi-official division of the population into three economic classes classed  
high-, middle-, and low-income groups rather misses the point, because as a class indicator the amount of 
money is not as important as the source.” 
 
WITH ELLIPSES: Paul Fussel argues that the “quasi-official division of the population into three economic 
classes…rather misses the point” (34). 
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A Sample Works Cited Page:           

 

                                                                                                                                        Sophomore 7     

Works Cited 

  “History.” Westminster Abbey. The Dean and Chapter of Westminster, 2016,  

   www.westminster-abbey.org/our-history. 

 Jenkyns, Richard.  Westminster Abbey.  Harvard UP, 2011. 

 Lawrence, Sandra, and Tracy Smith. “Westminster Abbey – The Royal Venue.” British Heritage,  

  July 2011, p. 60. MAS Ultra – School Edition.  

  “The London Abbey.” The Renaissance: An Encyclopedia for Students. Edited by Paul F. Grendler,                     

    Vol. 3, Charles Scribner’s Sons, 2004, pp. 27-29. Gale Virtual Reference Library.  

  Streissguth, Thomas. “Westminster Abbey.” The Greenhaven Encyclopedia of the Middle Ages.  

   Edited by Bruno Leon, Greenhaven Press, 2003, pp. 296-297. Gale Virtual Reference  

   Library. 

  “Westminster Abbey.” Great Britain: A Reference Guide from the Renaissance to the Present.  

   Edited by Richard S. Thomson and Frank J. Coppa, Facts on File, 2003, pp. 413-414.  

  “Westminster Abbey.” The Times. 29 Apr. 2011, pp. 12-13. Newspaper Source.  

  “Worship.” Westminster Abbey. The Dean and Chapter of Westminster, 2016, www.westminster-    

   abbey.org/worship. 

 

 

 

   

 
 

Title of the page centered 
 

Entries are alphabetized, double-spaced, 
and each line under the first is indented.  

 
Do not alphabetize by the articles a, an, 

and the when beginning an entry. 
 

1 inch margins all 
 around the paper 

 

Writing is double-spaced throughout the 
paper and skips every other line. 

 
The distance between paragraphs is the 

same as it is between lines. 
 

Writer’s last name and 
page number are ½ inch 
from the top of the paper 

in Times New Roman font 
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How to Format the Most Common Works Cited Entries 
 

The List of Works Cited 
 

The “Works Cited” page identifies the sources cited in the body of the research project. Each entry in the list of 
works cited is made up of nine core elements that are given in a specific order: 
 

1. Author. 
2. Title of source. 
3. Title of container, 
4. Other contributors, 
5. Version, 
6. Number, 
7. Publisher, 
8. Publication date, 
9. Location. 

 
The following explains each of the core elements in detail. 
 
1. Author. 

 
Begin the entry with the author’s last name, followed by a comma and the rest of the name, as presented in 
the work. End this element with a period. 

 
Jacobs, Alan. The Pleasures of Reading in an Age of Distraction. Oxford UP, 2011. 

 
When a source has two authors, include them in the order in which they are presented in the work. Reverse 
the first name as you would for a source with one author, follow it with a comma and the word and, and 
give the second name in normal order. 

 
Dorris, Michael, and Louise Erdich. The Crown of Columbus. HarperCollins Publisher, 1999. 

 
When a source has three or more authors, reverse the first of the names as just described and follow it with a 
comma and et al. (“and others”). 

 
Burdick, Anne, et al. Digital_Humantities. MIT P, 2012. 

 
When the source does not have an author listed, but does list an editor, use the editor’s name in the same 
way you would an author’s name. 

 
Nunberg, Geoffrey, editor. The Future of the Book. U of California P, 1996. 
 

A source with two or more editors is formatted like a work with two authors, followed by the word editors. 
  

Holland, Merlin, and Rupert Hart-Davis, editors. The Complete Letters of Oscar Wilde. Henry Holt, 

2000. 
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When you discuss a source that was translated from another language and your focus is on the translation, 
treat the translator as the author. 

Pevear, Richard, and Larissa Volokhonsky, translators. Crime and Punishment. By Feodor Dostoevsky, 

Vintage eBooks, 1993. 

Heaney, Seamus, translator. Beowulf. W. W. Norton, 2001. 

Pseudonyms, including online usernames, are mostly given like regular author names. 

@persiankiwi. “We have report of large street battles in east & west of Tehran now - #Iranelection.” 

Twitter, 23 June 2009, 11:15 a.m., twitter.com/persiankiwi/status/2298106072. 

Stendhal. The Red and the Black. Translated by Roger Gard, Penguin Books, 2002. 

When a work is published without an author’s name, do not list the author as “Anonymous.” Instead, skip 
the author element and begin the entry with the work’s title. 

Beowulf. Translated by Alan Sullivan and Timothy Murphy, edited by Sarah Anderson, Pearson, 2004. 

Authors do not have to be individual persons. A work may be created by a corporate author—an institution, 
an association, a government agency, or another kind of organization. 

United Nations. Consequences of Rapid Population Growth in Developing Countries. Taylor and 

Francis, 1991. 

When a work is published by an organization that is also its author, begin the entry with the title, skipping 
the author element, and list the organization only as the publisher. 

 Reading at Risk: A Survey of Literary Reading in American. National Endowment for the Arts, June 

 2004. 

 
2. Title of source. 
 

After the author, the next element included in the entry in the works cited list in the title of the source. List 
the title as it appears in full, but follow standard capitalization and punctuation rules.  The entire title is 
italicized (or underlined if you are handwriting your entry). 

 
Puig, Manuel. Kiss of the Spider Woman. Translated by Thomas Colchie, Vintage Book, 1991.  

 
If a subtitle is included after the main title. 

 
Joyce, Michael. Othermindedness: The Emergence of Network Culture. U of Michigan P, 2000. 
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The title of an essay, a story, or a poem in a collection, as a part of a larger whole, is placed in quotation 
marks.  
 

Dewar, James A., and Peng Hwa Ang. “The Cultural Consequences of Printing and the Internet.” Agent of 

Change: Print Culture Studies after Elizabeth L. Eisenstein, edited by Sabrina Alcorn Baron et 

al., U of Massachusetts P / Center for the Book, Library of Congress, 2007, pp. 365-77. 

When a novel or play appears in a collection (such as your anthology), the work’s title remains in italics. 
 

Euripides. The Trojan Women. Ten Plays, translated by Paul Roche, New American Library, 1998, pp. 

457-512. 

The title of a journal, magazine, or newspaper is set in italics, and the title of the article goes in quotation 
marks. 
 

Goldman, Anne. “Questions of Transport: Reading Primo Levi Reading Dante.” The Georgia Review, 

vol. 64, no. 1, 2010, pp. 69-88. 

The title of a television series appears in italics. 
 

Buffy the Vampire Slayer. Created by Joss Whedon, performance by Sarah Michelle Geller, Mutant 

Enemy, 1997-2003. 

The title of an episode of a television series goes in quotation marks. 
 

“Hush.” Buffy the Vampire Slayer, created by Joss Whedon, performance by Sarah Michelle Geller, 

season 4, episode 10, Mutant Enemy, 1999. 

The title of a Web site appears in italics. 
 

Hollmichel, Stefanie. So Many Books. 2003-12, somanybooksblog.com. 
 

A posting or an article at a Web site appears in quotations. 
 

Hollmichel, Stefanie. “The Reading Brain: Differences between Digital and Print.” So Many Books, 25 

Apr. 2013, somanybooksblog.com/2013/04/25/the-reading-brain-differences-between-digital-

and-print/. 

A song or other piece of music on an album appears in quotation marks. 
 

Beyoncé. “Pretty Hurts.” Beyoncé, Parkwood Entertainment, 2013, 

www.beyonce.com/album/beyonce/?media-view=songs. 
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When a source is untitled, such as a comment in an online forum, include a description. 

Jeane. Comment on “The Reading Brain.” So Many Books, 25 Apr. 2013, 10:30 p.m., 

somanybooksblog.com/2013/04/25/ print/#comment-83030. 

Identify a short untitled message, such as a tweet, by reproducing its full text, without changes, in  place 
of a title. Enclose the text in quotation marks. 

@persiankiwi. “We have report of large street battles in east & west of Tehran now - #Iranelection.” 

Twitter, 23 June 2009, 11:15 a.m., twitter.com/persiankiwi/status/2298106072. 

To document an e-mail message, use its subject as the title. The subject is enclosed in quotation marks  
and its capitalization standardized. 

 Boyle, Anthony T. “Re: Utopia.” Received by Daniel J. Cahill, 21 June 1997. 

 
 
 
3. Title of container, 

 
When the source being documented forms a part of a larger whole, the larger whole can be thought of as a 
container that holds the source. The title of the container is normally italicized and is followed by a comma, 
since the information that comes next describes the container.  

 
The container may be a book that is a collection of essays, stories, poems, or other kinds of works. 

 Bazin, Patrick. “Toward Metareading.” The Future of the Book, edited by Georffrey Nunberg, U of  

  California P, 196, pp. 153-166. 

The container may be a periodical (journal, magazine, newspaper), which holds articles, essays, and so on. 

Baron, Naomi S. “Redefining Reading: The Impact of Digital Communication Media.” PMLA, vol.  

 128, no. 1, Jan. 2013, pp. 193-200. 

Williams, Joy. “Rogue Territory.” The New York Times Book Review, 9 Nov. 2014, pp. 1+. 

The container may be a television series, which is made up of episodes. 

“Hush.” Buffy the Vampire Slayer, created by Joss Whedon, performance by Sarah Michelle Geller,  

 season 4, episode 10, Mutant Enemy, 1999. 

The container may be a Web site, which contains articles, postings, and almost any other sort of work. 

Hollmichel, Stefanie. “The Reading Brain: Differences between Digital and Print.” So Many Books,  

 25 Apr. 2013, somanybooksblog.com/2013/04/25/the-reading-brain-differences. 
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In some cases, you may have two containers. 

For an article that appeared in a journal (container 1) that is now contained in an online database 
(container 2), use the following format: 
 

Goldman, Anne. “Question of Transport: Reading Primo Levi Reading Dante.” The Georgia Review,  

 vol. 64, no. 1, 2010, pp. 69-88. JSTOR, www.jstor.org/stable/41403188. 

For an article that appeared in a periodical (container 1) that is now contained in an online database 
(container 2), use the following format: 
 
 Lawrence, Sandra, and Tracy Smith. “Westminster Abbey – The Royal Venue.” British Heritage,  

  July 2011, p. 60. MAS Ultra – School Edition, web.a.ebscohost.com/ehost/detail/detail?vid. 

If you watch an episode of a television series (container 1) online through a service such as Hulu 
(container 2). 
 

“Under the Gun.” Pretty Little Liars, season 4, episode 6, ABC Family, 16 July 2013. Hulu, 

www.hulu.com/watch/511318. 

 
 
4. Other contributors, 

 
Aside from an author whose name appears at the start of the entry, other people may be credited in the 
source as contributors. Use a description of the role before each name. The following are common 
descriptions: 

• adapted by 
• directed by 
• edited by 
• illustrated by 

• introduced by 
• narrated by 
• performance by 
• translated by 

 
The editors of scholarly editions and of collections are usually recorded. 

 
Deward, James A., and Peng Hwa Ang. “The Cultural Consequences of Printing and the Internet.” 

Agent of Change: Print Culture Studies after Elizabeth L. Eisenstein, edited by Sabrina Alcorn 

Baron, et al., U of Massachusetts P / Center for the Book, Library of Congress, 2007, pp. 365-77. 

 
Translators are also usually recorded. 

 
Chartier, Roger. The Order of Books: Readers, Authors, and Libraries in Europe between the  

Fourteenth and Eighteenth Centuries. Translated by Lydia G. Cochrane, Stanford UP, 1994. 
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If a source such as a film, television episode, or performance has many contributors, include the ones 
most relevant to your project. For example, if you are writing about a television episode and focus on a key 
character, you might mention the series creator and the actor who portrays the character. 

 
“Hush.” Buffy the Vampire Slayer, created by Joss Whedon, performance by Sarah Michelle Geller, 

season 4, episode 10, Mutant Enemy, 1999. 

 

5. Version, 
 
If the source is a version released in more than one form, identify the version in your entry.  

The Bible. Authorized King James Version, Oxford UP, 1998. 

Cheyfitz, Eric. The Poetics of Imperialism: Translation and Colonization from The Tempest to 

  Tarzan. Expanded ed., U of Pennsylvania P, 1997. 

Miller, Casey, and Kate Swift. Words and Women. Updated ed., HarperCollins Publishers, 1991. 

Newcomb, Horace, editor. Television: The Critical View. 7th ed., Oxford UP, 2007. 

Words in other media may also appear in versions. 

Schubert, Franz. Piano Trio in E Flat Major D 929. Performance by Einer Mozart-Trio, unabridged  

version, Deutch 929, Preiser Records, 2011. 

Scott, Ridley, director. Blade Runner. 1982. Performance by Harrison Ford, director’s cut, Warner  

 Bros., 1992. 

Shakespeare, William. The Tragedy of Othello. Edited by Barbara Mowat and Paul Werstine, version  

1.3.1, Luminary Digital Media, 2013. 

 
 
 

6. Number, 
 

The source you are documenting may be part of a numbered sequences. For example, a text may be issued 
in multiple volumes. If you consult one volume of a numbered multi-volume set, indicate the volume 
number. 

 
Rampersad, Arnold. The Life of Langston Hughes. 2nd ed., vol. 2, Oxford UP, 2002. 
 
Wellek, Rene. A History of Modern Criticism, 1750-1950. Vol. 5, Yale UP, 1986. 
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Journals are typically numbered with a volume and issue number.  

 
Baron, Naomi S. “Redefining Reading: The Impact of Digital Communication Media.” PMLA, vol.  

128, no. 1, Jan. 2013, pp. 193-200. 

The seasons of a television series are typically numbered in sequence, as are the episodes in a season. 
 

“Hush.” Buffy the Vampire Slayer, created by Joss Whedon, performance by Sarah Michelle Geller,  

season 4, episode 10, Mutant Enemy, 1999. 

 
 
 

7. Publisher, 
 

The publisher is the organization responsible for making the source available to the public. To determine 
the publisher of a book, look first on the title page. If no publishers name appears there, look on the 
copyright page (usually the page that follows the title page). 

 
Jacobs, Alan. The Pleasures of Reading in an Age of Distraction. Oxford UP, 2011. 

 
For films and television series, cite the company that had the primary overall responsibility for it. 

 
Kuzui, Fran Rubel, director. Buffy the Vampire Slayer. Twentieth Century Fox, 1992. 

 
Web sites are published by the various kinds of organizations, including museums, libraries, and 
universities and their departments. The publisher’s name can often be found in a copyright notice at the 
bottom of the home page or on a page that gives information about the side. 

 
Harris, Charles. “Teenie.” Woman in Paisley Shirt behind Counter in Record Store. Teenie Harris 

         Archive, Carnegie Museum of Art, Pittsburgh, teenie.cmoa.org/interactive/indext.html#date08. 

   
A publisher’s name may be omitted for the following kinds of publications: 

• A periodical (journal, magazine, newspaper) 
• A work published by its author or editor 
• A Web site whose title is essentially the same as the name of its publisher (for example, 

CNN) 
• A Web site not involved in producing the works it makes available (such as service like 

WordPress or YouTube, or an archive like JSTOR or ProQuest). 
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Abbreviating Publisher Names 
 

When using publishers’ names on the works cited page, omit business words: 
• Company (Co.) 
• Corporation (Corp.) 

• Incorporated (Inc.) 
• Limited (Ltd.) 

 
In the names of academic presses, replace: 

• University Press with UP (“U of Chicago P,” “Teachers College P”) 
 
Otherwise, write publishers’ names in full. 

 
 
 

8. Publication date, 
 

When documenting a book, look for the date of publication on the title page. If the title page does not 
indicate the date, check the book’s copyright page. 

 
Ellison, Ralph. Invisible Man. Vintage Books, 1995. 
 

 
An issue of a periodical (journal, magazine, newspaper) usually carries a date on its cover or title page. 
Periodicals vary in their publication schedules; they may publish every year, season, month, week, or day. 

 
Baron, Naomi S. “Redefining Reading: The Impact of Digital Communication Media.” PMLA, vol. 

128, no. 1, Jan. 2013, pp. 193-200. 

Belton, John. “Painting by the Numbers: The Digital Intermediate.” Film Quarterly, vol. 61, no. 3, 

Spring 2008, pp. 58-65. 

Kafka, Ben. “The Demon of Writing Paperwork, Public Safety, and the Reign of Terror.” 

Representations, no. 98, 2007, pp. 1-24. 

 
When a source carried more than one date, cite the date that is most meaningful or most relevant to your 
use of the source. If you consult an article on the Web site of a news organization that also publishes 
its article in print, use the date of the online version only. 

 
Deresiewicz, William.  “The Death of the Artist—and the Birth of the Creative Entrepreneur.” The  

 Atlantic, 28 Dec. 2014, www.theatlantic.com/magazine/archive/2015/01/the-death-of-the-artist  

 -and-the-birth-of-the-creative-entrepreneur/383497/. 

 
 If you consulted the print version of the article, cite only the print information. 
 

Deresiewicz, William.  “The Death of the Artist—and the Birth of the Creative Entrepreneur.” The 

Atlantic, Jan.-Feb. 2015, pp. 92-97. 
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 For documenting an episode of a television series, use the year of its original release. 
 

“Hush.” Buffy the Vampire Slayer, created by Joss Whedon, performance by Sarah Michelle Geller, 

season 4, episode 10, Mutant Enemy, 1999. 

 
 If you are exploring features of that episode found on a DVD set, use the date of release. 
 

“Hush.” 1999. Buffy the Vampire Slayer: The Complete Fourth Season, created by Joss Whedon, 

performance by Sarah Michelle Geller, episode 10, Twentieth Century Fox, 2003, disc 3. 

 
An entry for a video on a Web site includes the date when the video was posted there. 

 
“Buffy the Vampire Slayer: Unaired Pilot 1996.” YouTube, uploaded by Brian Stowe, 28 Jan. 2012, 

www.youtube.com/watch?v-WR3J-v7QXXW. 

 
For an article on the Web, use the date of publication. 

 
Hollmichel, Stefanie. “The Reading Brain: Differences between Digital and Print.” So Many Books, 

25 Apr. 2013, somanybooksblog.com/2013/04/25/the-reading-brain-differences-between-

digital-and-print/. 

 
Comments posted on Web pages are usually dated. If an article, a comment, or another source includes 
a time when the work was posted or last modified, include the time along with the date. 

 
Jeane. Comment on “The Reading Brain: Differences between Digital and Print.” So Many Books, 

25 Apr. 2013, 10:30 p.m., somanybooksblog.com/2013/04/25/the-reading-brain-

differencesbetween-digital-and-print/#comment-83030. 

 
Abbreviating Months 
The following abbreviations should be used when writing the months in a works cited entry: 

 
Month Abbreviation 

January Jan. 
February Feb. 

March Mar. 
April Apr. 
May May 
June June 
July July 

August Aug. 
September Sept. 

October Oct. 
November Nov. 
December Dec. 
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9.  Location. 

 
How to specify a work’s location depends on the medium of publication. 

 
In print sources, indicate the page number or range of page numbers. 

 
Adichie, Chimamanda Ngozi. “On Monday of Last Week.” The Thing around Your Neck, Alfred A. 

Knopf, 2009, pp. 92-97. 

 
For an online work, indicate its URL, or web address. 

 
Deresiewicz, William.  “The Death of the Artist—and the Birth of the Creative Entrepreneur.” The 

Atlantic, 28 Dec. 2014, www.theatlantic.com/magazine/archive/2015/01/the-death-of-the-

artist-and-the-birth-of-the-creative-entrepreneur/383497/. 

 
 

For a television episode in a DVD set, indicate the disc number. 
 

“Hush.” 1999. Buffy the Vampire Slayer: The Complete Fourth Season, created by Joss Whedon, 

performance by Sarah Michelle Geller, episode 10, Twentieth Century Fox, 2003, disc 3. 

 
For a physical object that you experienced firsthand, such as a work of art in a museum, provide the 
name of the place and the city (but omit the city if it is part of the place’s name). 

 
Bearden, Romare. The Train. 1975, Museum of Modern Art, New York. 

 
 
 
Optional Elements 
 
 The six core elements of the entry should be included, if they exist; however, there are also optional 
 elements that also may be included. 
 
 If a work has been republished, you may want to include the date of original publication. 
 

 Franklin, Benjamin. “Emigration to America.” 1782. The Faber Book of America, edited by 

 Christopher Ricks and William L. Vance, Faber and Faber, 1992, pp. 24-26. 

 
 It may be helpful to include the city of publication for pre-1900 work.  

 Goethe, Johan Wolfgang von. Conversations of Goethe with Eckermann and Soret. Translated by 

 John Oxenford, new ed., London, 1875. 
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You may also want to include the city of publication if publisher with offices in more than one country 

 releases a novel in two versions—perhaps with different spelling and vocabulary. 
 

  Rowling, J. K. Harry Potter and the Philosopher’s Stone. London, Bloomsbury, 1997. 
 

 In the case of an unexpected type of source, you may want to identify the type with a descriptive term.  
 

  Fresh Air. Narrated by Terry Gross, National Public Radio, 20 May 2008. Transcript. 
 
 A lecture or other address heard in person may be indicated as such. 
                    

 Atwood, Margaret. “Silencing the Scream.” Boundaries of the Imagination Forum. MLA Annual 

 Convention, 29 Dec. 1993, Royal York Hotel, Toronto. Address. 
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MLA Template for a Source from Gale Virtual Reference Library 
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MLA Template for a Source from Gale Virtual Reference Library 
 
1 
 

Author. Hacht, Anne Marie, editor.  

2 
 

Title of Source. "Romeo and Juliet." 

 
Container 1 
3 Title of container, 

 

Shakespeare for Students: Critical Interpretations of Shakespeare's Plays and 
Poetry, 

4 Other contributors, 
 

 

5 Version, 2nd ed., 

6 Number, vol. 3, 

7 Publisher, Gale, 

8 Publication date, 2007, 

9 Location. pp. 764-787. 

 
Container 2 
3 
 

Title of container, Gale Virtual Reference Library, 

4 
 

Other contributors,  

5 
 

Version,  

6 
 

Number,  

7 
 

Publisher,  

8 
 

Publication date,  

9 
 

Location. go.galegroup.com/ps/i.do?p=GVRL&sw=w&u=gran98056&v=2.1&it=r&id=GA
LE%7CCX2896100036&asid=2422495a4ab97f1ec1b318bea9e93b01. 

 
Anne Marie Hacht, editor. "Romeo and Juliet." Shakespeare for Students: Critical Interpretations of 

Shakespeare's Plays and Poetry, , 2nd ed., vol. 3, Gale, 2007, pp. 764-787. Gale Virtual Reference 

Library, go.galegroup.com/ps/i.do?p=GVRL&sw=w&u=gran98056&v=2.1&it=r&id=GALE%7CCX2 

 896100036&asid=2422495a4ab97f1ec1b318bea9e93b01. 
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MLA Template for a Source from Infohio 
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MLA Template for a Source from Infohio 

 
1 
 

Author. Wells, Andrew. 

2 
 

Title of Source. “A Night to Forget.”  

 
Container 1 
3 Title of container, History Today,  

4 Other contributors,  

5 Version, vol. 62, no. 4,  

6 Number,  

7 Publisher,  

8 Publication date, Apr. 2012,  

9 Location. pp. 13-19.  

 
Container 2 
3 
 

Title of container, 
 

Academic Search Premier,  

4 
 

Other contributors, 
 

 

5 
 

Version, 
 

 

6 
 

Number, 
 

 

7 
 

Publisher, 
 

 

8 
 

Publication date, 
 

 

9 
 

Location. 
 

search.ebscohost.com/login.aspx?direct=true&AuthType=cookie,ip,custuid&cus
tid =infohio&db=aph&AN=74184834&site=ehost-live 

 
Wells, Andrew. “A Night to Forget.” History Today, vol. 62, no. 4, Apr. 2012, pp. 13-19. Academic Search 

Premier, search.ebscohost.com/login.aspx?direct=true&AuthType=cookie,ip,custuid&custid 
=infohio&db=aph&AN=74184834&site=ehost-live. 
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MLA Template for a Book Source 
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MLA Template for a Book Source 

 
1 
 

Author. Westerfeld, Scott. 

2 
 

Title of Source. Leviathan. 

 
Container 1 
3 Title of container, 

 

 

4 Other contributors, 
 

Illustrated by Keith Thompson, 

5 Version, 
 

reprint ed., 

6 Number, 
 

 

7 Publisher, 
 

Simon Pulse, 

8 Publication date, 
 

2010. 

9 Location. 
 

 

 
Container 2 
3 
 

Title of container, 
 

 

4 
 

Other contributors, 
 

 

5 
 

Version, 
 

 

6 
 

Number, 
 

 

7 
 

Publisher, 
 

 

8 
 

Publication date, 
 

 

9 
 

Location. 
 

 

 
Westerfeld, Scott. Leviathan. Illustrated by Keith Thompson, reprint ed., Simon Pulse, 2010.
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How to Format In-Text Citations 
 
In-text citations are references within the research paper to each source that is listed on the works cited 
page.  They lead the reader directly to the source used. The goal of the in-text citation is to be brief and 
clear. A typical in-text citation is composed of the element that comes first in the entry from the works 
cited page (usually the author’s last name or title).  It should be placed, in parenthesis, where there is a 
natural pause in the text.   
 
Listed below are general rules for formatting in-text citations. 
 
1. For a source with an author, use the author's last name and page number. Do not put a "p" for page. Do not 
use any commas.  
 

A noted linguist explains that Monty Python humor often relied on bizarre interactions (Crystal 107). 
 
An in-text citation that directly follows a quotation is placed after the closing quotation mark. 
 

According to Naomi Baron, reading is “just half of literacy.  The other half is writing” (194).  

 
2.  If the entry begins with the names of two authors, include both last names in the in-text citation, connected 
by and.   
 

Some economists recommend that employment be redefined to include unpaid domestic labor              
(Clark and Smith 39). 

 
3.  If the source has three or more authors, the in-text citation corresponds to the entry from the works cited list, 
which begins with the first author’s name followed by et al.  
 

Legal experts counter Smith, Yang, and Moore's argument by noting that the current spike in gun violence in 
America compels law makers to adjust gun laws (Jones et al. 4). 

 
4.  When a source has no page numbers, no number should be given in a parenthetical citation. 

 
5.  When a title is needed in an in-text citation, abbreviate the title if it is longer than a phrase.  The abbreviated 
title should begin with the word by which the title is alphabetized.  Use the first noun and any preceding 
adjectives.  Make sure to exclude the articles a, an, the and use corresponding italics or quotation marks. 
 

Full Title Abbreviation 
The Double Vision: Language and Meaning in Religion Double Vision 

“Traveling in the Breakdown Lane” “Traveling” 
“You Say You Want a Revolution? Hypertext and the Media” “You” 

And Quiet Flows the Don And 
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6.  In citing poems and verse plays with line numbering, omit page number and cite by divisions (act, scene, 
canto, book, part) and line, separating the number with periods.  In your first citation write out the word line or 
lines and then, for successive in-text citations, give the numbers alone. 
 

According to the narrator of Felicia Heman’s poem, the prisoners “had learn’d, in cells of secret gloom, / 
How sunshine is forgotten” (lines 131-32). 
 
Hamlet seems resolute at first when he asserts, “Haste me to know’t, that I, with wings as swift / As 
meditation…./ May sweep to my revenge” (1.5.35-37). 

 
7.  An e-book may include a numbering system that tells users their location in the work.  Because this 
numbering varies, do not cite it.  Instead, cite numbered sections like chapters and label the type of part that is 
numbered. 
 

According to Hazel Rowley, Franklin and Elenor Roosevelt began their honeymoon with a week’s stay at 
Hyde Park (ch. 2). 

 
A source without page numbers or any other form of fixed numbering must be cited as a whole.  Include enough 
information for the reader to find the entry in the works cited page. 
 

The authors state "Tighter gun control in the United States erodes Second Amendment rights" (Smith and 
Moore). 

 
8.  If using a quotation from a source in which it was already quoted, indicate that the information comes from 
someone else's research by using the abbreviation qtd. in.  
 

Arthur Miller says, "When somebody is destroyed everybody finally contributes to it, but in Willy's case, the 
end product would be virtually the same" (qtd. in Martin and Meyer 375). 

 
9.  Citations of multiple sources in a single parenthesis are separated by semicolons. 
 

Lightenor has argued that computers are not useful tools for small children. He has acknowledged elsewhere 
that early exposure to computer games does lead to better small motor skill development in a child's second 
and third year (Baron 194; Jacobs 55) 

 
8.  Citations of different locations in a single source are separated by commas. 
 

Any study of social welfare involves a close analysis of the “impacts, the benefits, and the costs” of its 
policies (Baron 194, 200, 197-98). 
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9.  If the works cited page contains multiple works by the same author, the titles (shortened if necessary) should 
be included in the in-text citation.   
 

Werner Herzog's Fitzcarraldo stars Herzog's long-time film partner, Klaus Kinski. During the shooting of 
Fitzcarraldo, Herzog and Kinski were often at odds, but their explosive relationship fostered a memorable 
and influential film (Smith, Encyclopedia 45). Today’s viewings of the film seem to reinforce this idea 
(Smith, Foundations 22).  

 
If it contains works by more than one author with the same last name, add the author’s first initial to the last 
name in the in-text citation. 
  

Although some believe that the President’s potential plan is effective (R. Miller 12), others note that the dis-
advantages outweigh the advantages (A. Miller 46). 

 
10.  For works in audio or video recording, cite the relevant time or range of times.  Give the numbers of hour, 
minute, and seconds as displayed in the media player.  Separate the numbers with colons. 

Buffy’s promise that “there’s not going to be any incidents like at my old school” is obviously not one on 
which she can follow through (“Buffy” 00:03:16-17). 
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Avoiding Plagiarism 
 
Granville High School takes a strong stance against academic dishonesty, which includes plagiarism. According 
to the student handbook, plagiarism refers to: 
 

1. Submitting images and/or documents in whole or in part from the Internet without citations 
2. Copying another’s work 
3. Using another’s ideas without proper citations 
4. Incorporation portions of another’s writings within the context of your own work. 
5. Failing to acknowledge source information. 

 
To avoid plagiarism while writing a research paper use citations every time you are use another person’s ideas 
or words. 
 

• Use quotation marks around words taken directly from a text and provide a citation. 
• When summarizing or paraphrasing another person’s words, do more than replace or rearrange a few 

words, and provide a citation. 
 
Remember that you do not need to cite common knowledge, which is information that can be found in 
numerous places and is likely to be known by many people (For example, George Washington was the first 
president of the United States).  However, you must document facts that are not generally known and ideas that 
interpret facts. PLEASE refer to the instructions of your teacher for specific guidelines about common 
knowledge based on your assignment and grade-level.   
 
 
The Original Text from Elaine Tyler May’s “Myths and Realities of the American Family”: 
 
Because women’s wages often continue to reflect the fiction that men earn the family wage, single mothers 
rarely earn enough to support themselves and their children adequately.  And because work is still organized 
around the assumption that mothers stay home with children, even though few mothers can afford to do so, 
child-care facilities in the United States remain woefully inadequate. 
 

 Student version written in a paper  Is this plagiarism or not? 

Ve
rs

io
n 

A
 

 

Since women’s wages often continue to 
reflect the mistaken notion that men are the 
main wage earners in the family, single 
mothers rarely make enough to support 
themselves and their children very well.  Also, 
because work is still based on the assumption 
that mothers stay home with children, 
faculties for childcare remain woefully 
inadequate in the United States. 

This version is plagiarism because there is 
too much direct borrowing in sentence 
structure and wording.  The writer changes 
some words, drops one phrase, and adds some 
new language, but the overall text closely 
resembles May’s.  Even with a citation, the 
writer is still plagiarizing because the lack of 
quotation marks indicates that Version A is a 
paraphrase, and should thus be in the writer’s 
own language. 
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Ve
rs

io
n 

B
 

 
As Elaine Tyler May points out “women’s 
wages often continue to reflect the fiction that 
men earn the family wage” (558).  Thus many 
single mothers cannot support themselves and 
their children adequately.  Furthermore, since 
work is based on the assumption that mothers 
stay home with children, facilities for day 
care in this country are still “woefully 
inadequate” (May 589). 
 

Version B is also plagiarism because even 
though the writer cites May, the text continues 
to borrow too much language. 
 

Ve
rs

io
n 

C
 

 

By and large, our economy still operates on 
the mistaken notion that men are the main 
breadwinners in the family.  Thus, women 
continue to earn lower wages than men.  This 
means, in effect, that many single mothers 
cannot earn a decent living.  Furthermore, 
adequate day care is not available in the 
United States because of the mistaken 
assumption that mothers remain at home with 
their children. 
 

Version C shows good paraphrasing of the 
wording and sentence structure, but May’s 
original ideas are not acknowledged.  Some of 
May’s points are common knowledge (women 
earn less than men, many single mothers live 
in poverty), but May uses this common 
knowledge to make a specific and original 
point and her original conception of this idea 
is not acknowledged.  Thus version “C” is 
plagiarism. 
 

Ve
rs

io
n 

D
 

 

Women today still earn less than men- so 
much less that many single mothers and their 
children live near or below the poverty line.  
Elaine Tyler May argues that this situation 
stems in part from “the fiction that men earn 
the family wage” (588).  May further suggests 
that the American workplace still operates on 
the assumption that mothers with children 
stay home to care for them (589). 
 

Version D is not plagiarism because the 
writer makes use of the common knowledge in 
May’s work, but acknowledges May’s 
original conclusion and does not try to pass it 
off as his or her own. 
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Additional References 
 
 
For additional information on MLA format, the following sources are suggested: 
 
MLA Handbook for Writers of Research Papers. 8th ed., The Modern Language Association of America, 2016.  

Russell, Tony, et al. "MLA Formatting and Style Guide." The Purdue OWL, Purdue U Writing Lab, 31 Aug.  
 

2016, owl.english.purdue.edu/owl/resource/747/01/. 
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